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Аннотация 

 

Главная цель текущей работы заключается в моделировании различных объектов 

города, а именно объектов части района Ласнамяэ возле ледового холла Tondiraba 

Jäähall. Были смоделированы следующие модели: ледовый холл, девятиэтажные и 

пятиэтажные дома, два вида детской площадки, дороги, остановки, знаки, фонари и 

прочие небольшие объекты. Вся эта модель небольшой части города была 

реализована в виртуальной реальности с помощью Blender и Unreal Engine 4 для 

очков Oculus Rift. 

Все объекты для данной части района, кроме растительности были смоделированы в 

программе трехмерного моделирования Blender. Далее, модели всех объектов были 

импортированы в Unreal Engine 4, разрабатываемого и поддерживаемого компанией 

Epic Games. Для создания различных текстур использовался растровый графический 

редактор GNU Image Manipulation Program 2 или GIMP 2. 

За основу моделей были взяты реально существующие объекты в городе Таллинн, в 

районе Ласнамяэ. Текстуры были сделаны с помощью фотографий реальных 

объектов и различных покрытий.  

 

Реализация такого типа проектов требует много времени и усилий и в рамках одной 

бакалаврской работы не может быть рассмотрена. Данная дипломная работа будет 

затрагивать ту часть работы, которая была сделана в таких программах, как Blender и 

GIMP 2, то есть где проходило создание текстур, моделирование объектов и их 

текстурирование. 

 

Дипломная работа написана на русском языке и содержит текст на 30 страниц, 5 

глав и 42 рисунка. 
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Annotatsioon 

 

Käesoleva töö peamine eesmärk on modelleerida erinevaid linna objekte, täpsemalt objekte 

Lasnamäe linnaosa ja Tondiraba Jäähalli lähedal. Modelleeritud on järgmised mudelid: 

jäähall, üheksa- ja viiekorruselised majad, kahte tüüpi mänguväljakuid, teed, bussipeatused, 

liiklusmärgid, tänavavalgustuspostid ja muud väikesed objektid. Väikest linnaosast mudel 

oli realiseeritud Blenderis ja Unreal Engine 4 virtuaalreaalsuses prillide Oculus Riftile abil.  

Kõik selle piirkonna objektid modelleeriti kolmemõõtmelise modelleerimise programmis 

Blender. Kõikide objektide mudelid imporditi Unreal Engine 4, mida aredatakse ja 

toetatakse Epic Games ettevõttega. Erinevate tekstuuride loomiseks kasutati rastergraafika 

redaktor GNU Image Manipulation Program 2 ehk GIMP 2. 

Mudelite aluseks võeti tegelikult olemasolevad objektid Tallinna linna Lasnamäe linnaosas. 

Tekstuurid tehti kasutades objektide ja erinevate katete reaalseid pilte.   

Selle tüüpi projekte realiseerimine nõuab palju aega ja pingutusi ning ühe bakalaureusetöö 

raames ei saa seda käsitleda. Käesolev diplomitöö puudutab seda osa, mis on tehtud 

programmides Blender ja GIMP 2, see tähendab tekstuuride loomine, objektide 

modelleerimine ja tekstureerimine. 

Lõputöö on kirjutatud vene keeles ning sisaldab teksti 30 leheküljel, 5 peatükki, 42  joonist. 
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Abstract 

 
The main objective of this thesis is to model various city objects, specifically object of a 

part of Lasnamae district near the Tondiraba Ice Hall. There were next objects modelled: 

ice hall, 5 and 9 stories high apartment blocks, two different types of playground, roads, 

bus stops, road signs, road lights and various small objects. The whole model of a small 

part of city was implemented using Blender and Unreal Engine 4 for the Oculus Rift virtual 

reality headset. 

 

All the objects for that part of city, except for the foliage were modeled using 3d modeling 

software Blender. Then, all the objects were imported into the Unreal Engine 4 game 

engine, developed and supported by Epic Games. There was raster graphic editor GNU 

Image Manipulation Program 2 or GIMP 2 used to create various textures. 

 

Created models are based on real object in Tallinn city, in Lasnamae district. Textures were 

made with a help of photos of various real objects and surfaces. 

 

An implementation of such kind of a project requires a lot of time and effort, that is why it 

cannot be done within a single bachelor work. This diploma thesis only describes the part 

of work made in Blender and GIMP 2, i.e. texture creation, objects modeling and texturing. 

 

The thesis is in Russian and contains 30 pages of text, 5 chapters, 42 figures. 
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1.   Введение  

3D-моделирование – это разработка трехмерной модели какого-либо объекта. С 

помощью трехмерного моделирования можно создавать дубликат определенного 

предмета или объекта из реального мира, а также смоделировать что-то свое. На 

сегодняшний день в жизни человека постоянно используется трехмерная графика в 

различных отраслях, таких как индустрия развлечения, медицина и промышленность.  

 

В данной дипломной работе пойдет речь о трехмерном моделировании в Blender’е, о 

том, каким образом создавалась модель небольшой части района Ласнамяэ возле 

ледового холла Tondiraba. Все смоделированные объекты в данной дипломной работе 

созданы с помощью одного принципа моделирования – полигонального 

моделирования. Полигон – это многоугольник, который создается за счет соединения 

трех или более вершин ребрами. На полигон можно накладывать цвет и текстуру.  

 

Немаловажной частью моделирования считается текстурирование. От хорошей 

текстуры будет зависеть, насколько хорошо созданный объект повторяет объект из 

реального мира. Многие разработчики игр рисуют сами свои текстуры, но в данной 

работе используются фотографии реальных поверхностей для создания текстур.  

 

Перед тем, как приступить к моделированию объектов, необходимо создать какую-

нибудь поверхность со спутниковыми снимками карты, чтобы сверить готовую 

модель по карте и убедиться, что ее размеры повторяют реальные. Первым делом, 

рассмотрим, какой вариант был применен для получения снимков поверхности карты 

в данной работе. 

 

1.1 Цели 
 

Данная бакалаврская работа содержит следующие цели:  

• Создание карты;  

• Создание трехмерных моделей в Blender;  
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• Создание текстур;  

• Наложение текстур на объекты;  

• Завершающий этап создания моделей. 

 

1.2 Проблемы 
 

Проблемы, возникнувшие во время работы с моделями в Blender:  

• Уменьшение полигонов на объектах;  

• Удаление некоторых стен на ледовом холле и заборе;  

• Сложное текстурирование на некоторых местах объектов, например, на таких 

как трубы и перила. 
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2.   Создание карты части города 

После изучения двух программ, Blender и Unreal Engine 4, необходимо было решить, 

каким образом создать карту, с помощью которой можно было узнать 

местоположение объектов и сравнить размеры виртуальных объектов с реальными. В 

процессе изучения этого вопроса, было множество вариантов для создания карты, 

однако пришлось бы воспользоваться несколькими программами, у которых не было 

бесплатной лицензии. 

  

В самом начале было предложено воспользоваться снимками с Google Maps, но 

изображение было слишком размытым. Хорошей идеей было использовать 

спутниковые снимки с карт Maaamet, их разрешение выше, чем у карт Google. 

Однако на картах Maaamet нельзя вырезать ровные части изображения карты. 

Необходимо было получить спутниковые снимки размером 150х150 метров, так как 

это был один из рекомендуемых размеров создания ландшафта в Unreal Engine 4. 

Цель была такова – склеить 8 ландшафтов, на которых были сверху наложены 

изображения снимков части района. В итоге был использован сайт 

http://geoportaal.maaamet.ee/. Для измерения расстояния применялся инструмент 

vahemaade mõõtmine (линейка). Сама линейка в виде круга, по диаметру которой 

возможно было определить измеряемое расстояние. Процесс измерения участков 

линейкой по 150 метров проиллюстрирован на Рис. 1. Для того чтобы спутниковые 

снимки выглядели более точно, приближался как можно ближе один участок 150х150 

метров и делался снимок экрана. С помощью программы GIMP 2 в итоге получилось 

8 изображений карты. В результате сама карта, состоящая из 8 частей, вышла 

примерно размером 600х300 метров. 

 

 

http://xgis.maaamet.ee/xGIS/XGis?app_id=UU82&user_id=at&bbox=308228.395061728,6375000,796771.604938272,6635000&LANG=1
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Рисунок  1. Процесс измерения участков 

 

 

Рисунок  2. Конечная карта части района Ласнамяэ в Blender'е 
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3.   Создание модели в Blender 

Blender – бесплатный редактор для создания трёхмерной компьютерной графики, 

который дает возможность заниматься 3D моделированием, настраивать 

освещение, создавать анимации, текстурировать объекты, заниматься 

постобработкой и многое другое. Является одним из самых популярных ЗD - 

редакторов с открытым исходным кодом.  

 

Особенности интерфейса пользователя:  

1) Режимы редактирования, основными являются объектный режим (Object 

mode) и режим редактирования (Edit mode), которые переключаются 

клавишей Tab. Объектный режим используется для перемещения, вращения и 

масштабирования объектов, а режим редактирования – для более детальной 

обработки объекта. Вся работа с объектами обычно проходит именно в 

режиме редактирования. 

2) Использование горячих клавиш с помощью клавиатуры. 

3) Управление рабочим пространством. Графический интерфейс Blender’а 

состоит из одного или нескольких экранов, каждый из которых может быть 

разделён на секции. В своей работе автор в основном использовала только два 

экрана, на первом был открыт редактор 3D View – редактор для просмотра и 

работы с моделями, а на втором – UV/Image Editor – редактор для работы с 

текстурами. 

 

3.1 Начало создания модели 

 
Объекты могут быть разных видов, форм и размеров, поэтому в Blender имеется 

много различных инструментов. Каждый объект можно перемещать, вращать и 

масштабировать.  

 

Перед тем как приступить к созданию модели, нужно настроить единицы измерения 

в среде Blender’а. Сделать это можно следующим образом –  включить на базовой 

панели кнопок редактор Properties (обычно он сразу открыт при запуске программы), 
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на панели кнопок выбрать раздел Scene, после чего выбирается Metric, как 

изображено на Рис. 3. В конечном итоге вся система измерения будет в метрах.  

 

 

Рисунок  3. Системы измерения в программе в метрах 

 

Процесс создания объектов каждый раз начинался с добавления простого меш-обекта 

– плоскость (англ. Plane) через вкладку нижнего меню Add -> Mesh -> Plane в 

объектном режиме, как можно заметить на Рис. 4. После создания плоскости, нужно 

перейти в режим редактирования для дальнейшей работы создания модели. 

 

 

Рисунок  4. Добавление простого меш-объекта 
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Работа в Blender’е в основном проходила в режиме редактирования, поэтому ниже 

написаны основные горячие клавиши, которые были задействованы в данной работе 

в этом режиме:  

Клавиша TAB – переключает между собой  режим редактирования и объектный 

режим.  

Клавиша A – используется для выделения всех вершин, повторное нажатие этой 

кнопки приведет к снятию выбора с вершин. 

NumPad – управление режимами просмотра: 7 – вид сверху, 1 – вид спереди, 3 – вид 

сбоку, 0 – вид из камеры, 5 – режим перспективы/ортографический режим.  

Мышка – левая клавиша предназначена для управления 3D-курсором, правая для 

выделения вершин объектов, средняя для вращения и просмотра объектов под 

разным углом. 

Клавиша Shift – необходимо удерживать эту клавишу, чтобы делать многочисленные 

выделение правой клавишей мыши.  

Клавиша S – масштабирование выделенных объектов/вершин/ребер/граней. 

Клавиша G – перемещение выделенных объектов/вершин/ребер/граней по x, y, z 

осям. 

Комбинация Shift + D – дублирование выделенных объектов/вершин/ребер/граней. 

Клавиша E – вытягивает выделенные вершин/ребер/граней. 

Клавиша N – вызывает информационное окно выделенного объекта. Данные в этом 

окне можно изменять. Например, изменение расположение выделенного объекта на 

плоскости.  

Клавиша F – создает грань между выделенными вершинами. Чтобы создать грань, 

следует выделить не менее трех вершин.  

 

К вышеперечисленным клавишам, можно добавить одну важную опцию для 

создания объектов – Subdivide. При использовании Subdivide каждое выделенное 

ребро разбивается на два равных ребра, как можно видеть на Рис. 5. 
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Рисунок  5. Выбор функции Subdivide 

 

В объектном режиме в основном использовались комбинация Ctrl + J – 

объединяющая выбранные объекты в один объект, и клавиша P – наоборот 

разбивающая объект на разные объекты. 

 

 

Рисунок  6. Конечная модель пятиэтажного дома 
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3.2 Удаление лишнего на модели 
 

Ближе к концу процесса создания модели, ее необходимо проверить на предмет 

различных недочетов, таких как дублирование вершин, вывернутые нормали, 

лишние полигоны. 

 

Во-первых, необходимо удалить лишние вершины, ребра и грани.  

 

Во-вторых, необходимо проверить все нормали на модели, что возможно сделать с 

помощью Viewport Shading: Solid, смотри Рис. 7. В данной работе нормаль считается 

полигоном. Если же не совсем понятно, какие нормали вывернуты, то это легко 

можно проверить в Unreal Engine 4. 

 

 

Рисунок  7. Проверка нормалей с помощью Solid 

 

В случае вывернутых нормалей, нужно их выбрать и использовать следующую 

вкладку в нижнем меню: Mesh -> Normals -> Flip Normals, изображенное на Рис. 8. 

Но данный способ не всегда помогал. Иногда какая-нибудь сторона определенной 

модели в Unreal Engine 4 могла так и не появиться на объекте после настройки 

нормалей, поэтому приходись создавать ее заново вручную.  

 

В-третьих, все дублирующие вершины, которые находятся очень близко друг к другу 

можно удалить автоматически, с помощью меню: Mesh -> Vertices -> Remove 

Doubles, смотри Рис. 9.  
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Рисунок  8. Исправление вывернутых нормалей 

 

 

Рисунок  9. Удаление дублирующих вершин 

 

Если модель сделана в форме круга или цилиндра из небольшого количества 

полигонов,  то с помощью Shade Smooth можно сделать поверхность этих объектов 

гладкой, визуально увеличивая количество полигонов. Данную опцию можно сделать 

через Mesh -> Faces -> Shade Smooth, которая показана на Рис. 10. 
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Рисунок  10. Процесс создания гладкой поверхности 

 

3.3 Особенности создания некоторых моделей 
 

Определенные модели были созданы при использовании различных модификаторов. 

Из списка модификаторов, изображенных на Рис. 11, использовались Array, Boolean, 

Curve. Они были нужны для создания таких объектов, как окна на ледовом холле, 

дороги, бревна, окружающие детскую площадку.  

 

Все готовые объекты, при использовании которых применялись модификаторы, 

изображены ниже и полностью затекстурированы.  
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Рисунок  11. Набор модификаторов 

 

3.3.1 Ледовый холл «Tondiraba Jaahall» 
 

В данном случае хотелось бы рассмотреть, как создавались окна для ледового холла, 

учитывая их количество на всем здании. Первым делом создавалось одно окно 

квадратной формы, у которого было стекло и рама, после чего на него накладывались 

текстуры. Затем окно дублировалось, и его копии размещались по всему периметру  

ледового холла, соответственно их реальному расположению. В процессе 

размещения, окнам придавалась нужная форма как на Рис. 12.  

 

Окна обязательно должны быть отдельным объектом, так как модификатор не всегда 

работает стабильно, и стена холла может исчезнуть совсем. После того, как окна 

расставлены по одной стене холла, их необходимо выделить и разместить так, чтобы 

из стены были видны только рамы от них. Данное действие показано на Рис. 13. 
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Рисунок  12. Создание окон на ледовом холле 

 

 

Рисунок  13. Расположение оконных рам 

 

Затем необходимо активировать стену холла в объектном режиме и выбрать раздел 

Modifiers в правом меню, в котором применить модификатор Boolean и операцию 

Intersect в нем. Далее нужно применить данный модификатор к стене ледового холла, 

который проиллюстрирован на Рис. 14 и Рис. 15.  

 

После процесса модификации необходимо перейти в режим редактирования и 

удалить части окон, которые появились на стене холла после пересечения с объектом 

окон. На стене холла останутся отверстия для окон, которые заполнят объект с 

окнами. 
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Рисунок  14. Готовые окна на холле 

 

 

Рисунок  15. Модификатор Boolean 

 

 
Рисунок  16. Конечная модель ледового холла Tondiraba 
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Рисунок  17. Главный вход ледового холла Tondiraba 

 

Рисунок  18. Конечная модель ледового холла Tondiraba 
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3.3.2 Бревна на детской площадке 
 

Для создания бревен на детской площадке необходимо воспользоваться двумя 

модификаторами: Array и Curve. Array создает массив копий используемого объекта. 

Вершины копий базового объекта можно соединять между собой или наоборт 

отдалять друг от друга. Данный модификатор удобно применять c модификатором 

Curve, так как требуется расположить бревна по кругу. 

 

Первым делом создаются копии бревен с помощью модификатора Array в объектном 

режиме, как показано на  Рис. 19 и Рис. 20. 

 

 

Рисунок  19. Создание копий бревен с помощью Array 

 

 

Рисунок  20. Модификатор Array 
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Чтобы расположить бревна по кругу, нужно добавить в проект кривую в виде круга 

Circle и настроить ее размеры (Рис. 21). 

 

 

Рисунок  21. Добавление Circle 

 

Далее нужно выбрать снова бревна и добавить еще один модификатор под названием 

Curve. В модификаторе в списке объектов выбирается созданная кривая, как можно 

заметить на Рис. 22.  

 

 

Рисунок  22. Модификаторы Array и Curve 
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В итоге бревна будут расположены по кругу, что проиллюстрировано на Рис. 23. Их 

количество можно регулировать с помощью количества объектов в графе Count при 

выбранном Fixed Count в модификаторе Array. Когда все функции с двумя 

модификаторами выполнены, их необходимо применить на объекте. 

 

 

Рисунок  23. Расположение бревен по кругу 

 

 

Рисунок  24. Конечная модель бревен, расставленных вокруг детской площадки 
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3.3.3 Дороги 
 

Создание дорог похоже на процесс создания бревен вокруг детской площадки тем, 

что также используется два модификатора. Работа над дорогой начинается с создания 

одного бордюра, после чего применяется модификатор Array. Чтобы бордюры 

расставить так, как они расположены в действительности, необходимо добавить 

модификатор Curve. Перед тем, как это сделать, нужно добавить кривую в виде пути, 

как изображено на Рис. 25. 

 

В режиме редактирования придаем нужную форму пути, ориентируясь по 

спутниковым снимкам. После создания бордюров с двух сторон дороги, необходимо 

соединить все нижние вершины бордюров друг с другом клавишей F, в итоге 

получается дорога, на которую накладывается определенная текстура и сверху 

разметка. 

 

 

Рисунок  25. Добавление пути 
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Рисунок  26. Конечная модель дорог, вид сверху 

 

Рисунок  27. Конечная модель дорог 
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Рисунок  28. Пример одной парковки возле ледового холла Tondiraba 
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4.   Текстурирование моделей 

Blender позволяет контролировать внешний вид объекта, применяя цвет и текстуру. 

Для того, чтобы начать процесс наложения текстуры на объект, необходимо выбрать 

его полигоны и создать для них материал, на который в дальнейшем будет 

накладываться текстура. Материал создается всегда перед добавлением текстуры. 

Происходит это следующим образом: в режиме редактирования выбрать модель, в 

правом меню выбрать вкладку Material и создать новый материал, как представлено 

на Рис. 29. Открыть вкладку Texture и вставить свою созданную текстуру, что можно 

посмотреть на Рис. 30. 

 

Если необходимо создать объект с несколькими текстурами, следует выбрать 

необходимые грани объекта, выбрать нужный материал и нажать на кнопку Assign 

(Рис. 29). После этого одна часть объекта будет одного материала, а другая часть – 

другого.  

 

 

Рисунок  29. Создание материала 
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Рисунок  30. Добавление текстуры 

 

Важно также отметить, что материал и текстура должны иметь разное название, 

иначе позже Unreal Engine 4 будет переименовывать их, добавляя цифры 1,2,3 и т.д. 

по порядку, что может создать некоторую путаницу. Материалы разных объектов 

также необходимо называть по-разному, если их текстуры различаются.  

 

На странице ниже приведены примеры, как почтовый ящик и качели на детской 

площадке выглядят без текстур и с ними. Конечно, в Unreal Engine 4 эти объекты 

выглядят гораздо лучше, так как там настраивается их материал. 
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Рисунок  31. Почтовый ящик до 

наложения текстур на него 

Рисунок  32. Почтовый ящик после 

наложения текстур на него 

Рисунок  34. Качели на детской площадке после 

текстурирования 

Рисунок  33. Качели на детской площадке до 

текстурирования 
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4.1 Создание текстуры 
 

Первым делом необходимо сделать удачную фотографию того или иного покрытия, 

лучше всего делать это во время солнечной погоды. В облачную погоду фотографии 

получались более синими и не передали реальный вид. В большинстве случаев в ходе 

работы, из изображений необходимо было сделать бесшовные текстуры, в случае с 

фотографиями окон, знаков можно просто вырезать из целого изображения нужную 

часть и, при необходимости, отредактировать полученное, благодаря различным 

инструментам. Для вышеперечисленных целей в ходе работы использовался 

растровый графический редактор GNU Image Manipulation Program 2 или GIMP 2. 

GIMP 2 считается свободным подобием различных платных редакторов (например, 

Adobe Photoshop). Для создания текстуры использовались следующие инструменты:  

 штамп: выборочное копирование из изображения или текстуры при помощи 

кисти, который помогал ретушировать шов на текстуре 

 

 

Рисунок  35. Панель инструментов 

 

 смещение изображения, необходимое для создания бесшовной текстуры;  

выбрать данное действие можно через меню слой -> преобразования -> 

сместить (тут нужно регулировать значение сдвига по оси x и y) 
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Рисунок  36. Смещение изображения 

 

Некоторые текстуры получается делать бесшовными всего в два клика через меню 

фильтры -> карта -> без швов. Но чаще всего приходится делать такие текстуры 

вручную, убирая шов инструментом штамп. Например, кирпичную дорогу 

приходилось делать только вручную.  

 

Если имеются текстуры с неровной поверхностью, такая как кирпичная дорожка, 

каменное покрытие дома, то после того как текстура полностью готова, необходимо 

создать карту нормалей. Карта нормалей – текстура, которая создает эффект 

рельефной поверхности за счет черно-белой фотографии. Инструмента, 

позволяющего сделать это, нет изначально в редакторе, поэтому он был бесплатно 

скачан из Интернета в виде плагина. Карта нормалей делается следующим образом: 

меню  изображение -> режим -> градации серого (данный шаг необходим, так как 

текстуру нужно сделать черно-белой); изображение-> режим ->RGB (только для RGB 

изображения можно применить плагин normalmap); фильтры -> карта -> normalmap. 

В дальнейшем карта нормалей используется в Unreal Engine 4 в свойствах материала 

объекта.  
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Рисунок  37. Пример карты нормалей 

 

4.2 UV-текстурирование 
 

После процесса создания материала и добавления на него текстуры, если это 

необходимо, можно приступить к коррекции текстур на объектах. Одих из более 

удобных способов отображения 2D - текстур, наложенных на трехмерном объекте, 

является UV – развертка,  которую возможно открыть через редактор UV/Image 

Editor, как представлено на Рис. 38. 

 

Форму UV – развертки можно регулировать с помощью вершин/ребер/граней. Для 

того, чтобы открыть UV – развертку какого-либо объекта, необходимо в режиме 

редактирования выделить весь объект или его часть и нажать клавишу U, где 

выбратъ Unwrap или Smart UV Project, смотри Рис. 39. После чего автоматически 

создается UV – развертка объекта. 
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Рисунок  38. UV-развертка для столба 

 

 

Рисунок  39. Создание UV-развертки 
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5.   Завершающий этап создания модели 

Все, что было проделано до этого этапа, еще не означает, что вся работа с моделями 

закончилась. Автор хочет отметить еще несколько важных вещей, перед тем как 

окончить работу с объектами. 

 

5.1 Карта освещения 
 

Когда модели загружены в Unreal Engine 4, можно столкнуться с проблемой 

развертки для карты освещения. Карта освещения - текстура, на основе которой 

формируется освещение 3D-модели. При наложении текстур на объекты создается 

основная UV-карта. Чтобы создать карту освещения, надо перейти на панель кнопок 

в раздел Data и найти UV Maps, в которой создать новую UV-карту (Рис. 40).  

 

 

Рисунок  40. Создание новой UV Map 

 

После чего выделить весь объект и нажать клавишу U, выбрав Lightmap Pack, как 

показано на Рис. 41. 

 

 

Рисунок  41. Создание Lightmap 
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5.2 Экспорт моделей из Blender 
 

Если планируется открывать объекты из Blender’а в Unreal Engine 4 в формате FBX, 

то существует один простой способ экспортировать их. В меню File в разделе Export 

выбирается FBX (.fbx) и открытый объект экспортируется, как проиллюстрировано 

на Рис. 42. 

 

 

Рисунок  42. Экспорт модели детской площадки в FBX формат 
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Заключение 

Все объекты были смоделированы в программе Blender. Благодаря горячим 

клавишам и разным инструментам, создание объектов было довольно быстрым. За 

счет трех модификаторов Array, Curve и Boolean удалось сделать окна на ледовом 

холле, дороги, бревна вокруг детской площадки и забор возле ледового холла 

намного быстрее, чем изначально планировалось.  

 

Было создано значительное количество различных текстур с помощью редактора 

GIMP 2. Вся сложность текстурирования заключалась в округлых частях объектов, 

например, на трубах и перилах. Почему-то в этих частях текстура переворачивалась, 

и приходилось каждый полигон текстурировать отдельно.  

 

При завершении создания модели обязательно нужно проверить, отцентрована ли 

она на плоскости и прикреплен ли к ее центру 3D-курсор. Данное действие 

необходимо, потому что, импортируя объект в Unreal Engine 4, он может появиться 

далеко от 3D-курсора игрового движка, что совершенно неудобно для 

использования.  

 

Самым неожиданным моментом при создании модели было исчезновение некоторых 

его сторон при использовании модификатора Boolean. Решений было всего два: 

создать стену вручную, соединяя нужные вершины друг с другом, или заново 

применить модификатор Boolean на объекте. Первый вариант приходилось 

использовать чаще, чем второй.  

 

После того как все этапы  создания объекта выполнены, его можно без проблем 

экспортировать в формат FBX и продолжать с ним работу уже в игровом движке 

Unreal Engine 4. Все объекты в результате выглядят реалистично.  
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